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GRAPHIC USER INTERFACE END USER LICENSE AGREEMENT

Whenever YOU download or use the GRAPHIC USER INTERFACE (“GUI") this End User License Agreement (“License”)
applies to YOU, as final end user, and Licensor. Licensor means Datalogic IP Tech S.r.l. having its registered office at
Via San Vitalino 13, 40012 Calderara di Reno, VAT number 03159561202, Italy. This License governs your use of
the GUI and related user documentation (the “GUI”). Any Open Source used in a conjunction with the Software is
subject to the Open Source licenses available at the following website: http://www.datalogic.com/oss.

By downloading and/or using the GUI, YOU are agreeing to the terms of this License. If YOU don’t agree with any of
these terms, YOU cannot download or use the GUL.

a. License. Subject to the restrictions this License, Licensor grants YOU a non-exclusive, non-transferable, non-
sublicensable, limited license to download, install and use in object code form a single copy of the GUI only on one
single computer that YOU own or control, which system requirements shall comply with requirements provided by
Licensor, and solely in conjunction with Datalogic Laser Sentinel, defined below, for which it is intended for use.

Title to the licensed GUI shall be and remain with Licensor or the third party from whom Licensor has obtained a
license right. This License does not grant to YOU any intellectual property rights on GUI.

b. License Restrictions. YOU may not distribute or make the GUI available over a network where it could be used by
multiple devices at the same time, unless otherwise permitted in writing by Licensor.

YOU may not rent, lease, lend, sell, redistribute or sublicense the GUI. YOU may not copy (except as expressly
permitted by this), decompile, reverse engineer, disassemble, attempt to derive the source code of, modify or
adapt the GUI, in whole or in part, merge the GUI into another program, use the GUI in any manner inconsistent
with this License or create derivative works of the GUI, any updates, or any part thereof (except as and only to
the extent any foregoing restriction is prohibited by applicable law or to the extent as may be permitted by the
licensing terms governing use of this License). YOU may print copies of any user documentation provided in
online or electronic form for your personal use. If YOU breach these restrictions, YOU may be subject to
prosecution and damages and this License would be immediately terminated.

c. Changes of License. Licensor reserves the right to change all or a part of the License at any time. If Licensor does
that, Licensor will post the changed terms at the following website: http://www.datalogic.com. Click on Support >
Search by product and enter the Laser Sentinel family name, then select your product from the dropdown list. Click
on the Software & Utilities link to download the License.

IF YOU CONTINUE TO USE THE GUI AFTER LICENSOR POST CHANGED TERMS, THAN YOUR USAGE WILL CONSTITUTE
YOUR EXPLICIT ACCEPTANCE OF THE CHANGED TERMS.

Licensor is constantly evolving its products. This means Licensor may change or discontinue GUI (and/or our
website and any of our other services) without notice or any liability to YOU.

d. Termination. The license is effective until terminated by YOU or Licensor. Your rights under this license will
terminate automatically without notice from the Licensor if (i) YOU fail to comply with any term(s) of this license;
(ii) YOU delete the GUI; and, to the extent applicable, (iii) YOU use the GUI in connection with a paid service or
paid product, the end of the time period specified at time of purchase. Upon termination of the license, YOU
shall cease all use of the GUI, and destroy all copies, full or partial, of the GUI.

e. Datalogic Laser Sentinel. The GUI may enable access to Datalogic laser product, Datalogic Laser Sentinel for
configuration purposes.

f. Intellectual Property Rights. Except for the rights explicitly granted in this License, Licensor retains and/or control
all right, title and interest (including all copyright, patents, trademarks, service marks, trade secrets, or other
intellectual property rights) in the GUI, including the copies of the GUI on your computer. YOU acknowledge that
the GUI constitutes valuable trade secrets of Licensor or its third party licensors and that the GUI is protected by
intellectual property laws and treaties. YOU shall not remove, modify, or take any other action that would
obscure any copyright, trademark, patent marking, or other intellectual property notices contained in or on the
GUI. Certain of the product and service names used in this License and in the GUI may constitute trademarks of
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Licensor or third parties. YOU are not authorized to use any such trademarks, except as it is permitted by
applicable laws and agreements. All trademarks are the property of their respective owners.

g. NO WARRANTY. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE GUI IS AT YOUR SOLE RISK AND
THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE GUI IS PROVIDED "AS IS" AND “AS AVAILABLE”,
WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND APPLICATION PROVIDER HEREBY DISCLAIMS ALL
WARRANTIES AND CONDITIONS WITH RESPECT TO THE GUI AND ANY SERVICES, EITHER EXPRESS, IMPLIED OR
STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF
MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF
QUIET ENJOYMENT. LICENSOR DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE GUI,
THAT THE FUNCTIONS CONTAINED IN, THE GUI WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE
GUI OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE GUI WILL BE CORRECTED.
NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY LICENSOR OR ITS AUTHORIZED REPRESENTATIVE
SHALL CREATE A WARRANTY. SHOULD THE GUI PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL
NECESSARY REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES OR LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION
AND LIMITATIONS MAY NOT APPLY TO YOU.

h. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL LICENSOR BE LIABLE FOR
PERSONAL INJURY, OR ANY DIRECT, INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES
WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS
INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE
OR INABILITY TO USE THE GUI, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT
OR OTHERWISE) AND EVEN IF APPLICATION PROVIDER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU.

i. Export. YOU may not use or otherwise export or re-export the GUI except as authorized by United States law and
the laws of the jurisdiction in which the GUI was obtained. In particular, but without limitation, the GUI may not
be exported or re-exported (a) into any U.S. embargoed countries or (b) to anyone on the U.S. Treasury
Department's list of Specially Designated Nationals or the U.S. Department of Commerce Denied Person’s List or
Entity List or to anyone towards whom any EU Council Regulation impose restrictive and sanctioned measures. By
using the GUI, you represent and warrant that you are not located in any such country or on any such list. YOU
also agree that YOU will not use these products for any purposes prohibited by United States and EU law,
including, without limitation, the development, design, manufacture or production of nuclear, missiles, or
chemical or biological weapons.

l. Open source. Portions of GUI include or operate with Open Source software (“Open Source Software”).

Open Source Software is software covered by a publicly available license governed solely under Copyright law,
whereas the complete terms and obligations of such license attach to a licensee solely through the act of copying,
using and/or distributing the licensed software, such obligations often include one or more of attribution
obligations, distribution obligations, copy left obligations, and intellectual property encumbrances. The use of any
Open Source Software is subject to the terms and conditions of this License as well as the terms and conditions of
the corresponding license of each Open Source Software package. If there is a conflict between the terms and
conditions of this License and the terms and conditions of the Open Source Software license, the applicable Open
Source Software license will take precedence. Licensor is required to reproduce the software licenses,
acknowledgments and copyright notices as provided by the authors and owners, thus, all such information is
provided in its native language form, without modification or translation. Please reference and review the above
mentioned information to identify which Open Source Software packages have source code provided or available.

m. Confidentiality. YOU acknowledge that GUI content and associated documentation, including the specific
design and structure of individual programs, constitute trade secrets and/or copyrighted material of Licensor
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(and/or its third party’s licensors). YOU shall keep the GUI and any related material in strict confidence with all
applicable laws. YOU shall not disclose, provide, or otherwise make available the Proprietary Information of
Licensor or its third party licensors to any person and YOU will use such information only for internal business
purposes. YOU shall take steps to protect the this information no less securely than if it were your own
intellectual property. The provisions of this Proprietary Information Section shall survive and continue for five (5)
years after the termination of this License.

n. Applicable Law/Jurisdiction.

n.1 Both parties agree to the application of the laws of the country in which YOU obtained the license to govern,
interpret, and enforce all of Your and Licensor’s respective rights, duties, and obligations arising from, or relating in
any manner to, the subject matter of this License, without regard to conflict of law principles. The United Nations
Convention on Contracts for the International Sale of Goods does not apply.

n. 2 All rights, duties, and obligations are subject to the courts of the country in which YOU obtained the license.
For licenses granted to You who operate in the countries specified below, the following terms apply:
For Americas.

This License and the rights of the parties hereunder shall be governed by and construed in accordance with the laws
of the State of Oregon U.S.A, without regard to the rules governing conflicts of law. The state or federal courts of
the State of Oregon located in either Multnomah or Lane counties shall have exclusive jurisdiction over all matters
regarding this License, except that Licensor shall have the right, at its absolute discretion, to initiate proceedings in
the courts of any other state, country, or territory in which YOU reside, or in which any of your assets are located. In
the event an action is brought to enforce the terms and conditions of this License, the prevailing party shall be
entitled to reasonable attorneys’ fees, both at trial and on appeal.

Use, duplication, or disclosure of the Software by the U.S. Government is subject to the restrictions for computer
software developed at private expense as set forth in the U.S. Federal Acquisition Regulations at FAR 52.227-14(g),
or 52.227-19 or in the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013(c)(1)(ii),
whichever is applicable.

For Europe, Middle East and Africa

This License and the rights of the parties hereunder shall be governed by and construed in accordance with the laws
of Italy, without regard to the rules governing conflicts of law. Italian Court of Bologna shall have exclusive
jurisdiction over all matters regarding this License, except that Licensor shall have the right, at its absolute
discretion, to initiate proceedings in the courts of any other state, country, or territory in which YOU reside, or in
which any of Your assets are located. In the event an action is brought to enforce the terms and conditions of this
License, the prevailing party shall be entitled to reasonable attorneys’ fees, both at trial and on appeal.

For Asia- Pacific Countries
The validity, interpretation and construction of the License shall be governed by and construed in accordance with
Laws of the Republic of Singapore. Parties expressly disclaim the application of the United Nations Convention for
International Sale of Goods.

Any dispute arising out of or in connection with this contract, including any question regarding its existence,
validity or termination, shall be referred to and finally resolved by arbitration administered by the Singapore
International Arbitration Centre (“SIAC”) in accordance with the Arbitration Rules of the Singapore International
Arbitration Centre ("SIAC Rules") for the time being in force, which rules are deemed to be incorporated by reference
in this clause. The seat of the arbitration shall be Singapore.

The number of arbitrators will be three, with each side to the dispute being entitled to appoint one arbitrator. The
two arbitrators appointed by the parties will appoint a third arbitrator who will act as chairman of the proceedings.
Vacancies in the post of chairman will be filled by the president of the SIAC. Other vacancies will be filled by the
respective nominating party. Proceedings will continue from the stage they were at when the vacancy occurred. If
one of the parties refuses or otherwise fails to appoint an arbitrator within 30 days of the date the other party
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appoints its, the first appointed arbitrator will be the sole arbitrator, provided that the arbitrator was validly and
properly appointed. All proceedings will be conducted, including all documents presented in such proceedings, in
the English language. The English language version of these terms and conditions prevails over any other language
version.

n3._Attorneys’ Fees. In the event an action is brought to enforce the terms and conditions of this License, the
prevailing party shall be entitled to reasonable attorneys' fees, both at trial and on appeal. Proposals, oral or written,
and all other communications between the parties relating to the subject matter of this License. Any terms and
conditions of any purchase order or other instrument issued by YOU in connection with this License which are in
addition to, inconsistent with or different from the terms and conditions of this License shall be of no force or
effect. This License may be modified only by a written instrument duly executed by the parties. Any waiver by either
party of any condition, part, term, or provision of this License shall not be construed as a waiver of any other
condition, part, term or provision or a waiver of any future event or circumstance. If any provision of this License is
held unenforceable, or invalid, the remainder of the License shall continue in full force and effect.

Effective. November 10, 2017.
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REFERENCES

CONVENTIONS
This manual uses the following conventions:
"DLSentinel" refers to the Datalogic User Interface client application running on a PC.
"User” or “Installer” refers to anyone using DLSentinel.
"Device” refers to physical devices used in the safety application, i.e. Laser Sentinel.
"You” refers to the System Administrator or Technical Support person using this manual to install, configure,
operate, maintain or troubleshoot a plant equipped with DLSentinel.
REFERENCE DOCUMENTATION
The documentation related to DLSentinel is listed below:

e Device specific Help On Line

e This User’'s Manual

e Laser Sentinel Instruction Manual

SUPPORT THROUGH THE WEBSITE

Datalogic provides several services as well as technical support through its website. Log on to
www.datalogic.com and click on the SUPPORT link, which gives you access to:

e Downloads by selecting your product model from the dropdown list in the Search by Product field for
specific Data Sheets, Manuals, Software & Utilities and Drawings;

e Repair Program for On-Line Return Material Authorizations (RMAs) plus Repair Center contact
information;

e Customer Service containing details about Maintenance Agreements;

e Technical Support through email or phone.
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1 DLSENTINEL GRAPHIC USER INTERFACE

1.1 PROGRAM DESCRIPTION

DLSentinel is a User Interface client application that provides device configuration for the Laser Sentinel series of
safety laser scanners. It is installed in and runs on Windows-based PCs, and connection takes place through an

Ethernet TCP/IP interface.

COATALOGIC

Fie  Sca
Help Task Selection

Getting Started E New Safety System Configuration

" e Create a new Safety System Configuration

Open a Safety System Configuration From PC

Modify Safety System Configuration From a Scanner on the Network
Eatt a Safety System Configuration From a Scanner on the Network
« New Safety System
Monitor Safety System
Read a Safety System Report from a Scanner on the Network
Show a Safety System Report from a Scanner on the Network
Read a Safety System Report from PC
Show a Safety System Report from Pt

|
Main features
A summary of the DLSentinel main features is listed below:

e Settings for changing the device’s password and to manage the network configuration

e User and Session Language configuration in real time

e System configuration

e Report

e Manual

Pag. 9/75



DLSENTINEL == DAtALOCIIC

1.2 BEFORE USING DLSENTINEL

To employ the device, a safety configuration with the DLSentinel GUI must be created, where the user will enter all
the parameters, configure inputs and outputs and create monitored areas.

1.3 INSTALLING DLSENTINEL

The DLSentinel client application software needs to be installed on your PC to configure the safety laser scanner.

1.3.1 Minimum System Requirements

To ensure proper interfacing with the system, the personal computer must meet the following minimum
requirements:

COMPONENT ' RECOMMENDED MINIMUM
Processor(s) Pentium 4 Pentium 4
Clock frequency >= 3 GHz >=2 GHz
RAM 2GB 1GB

Free hard drive space 70 MB 70 MB
Monitor resolution 1280x768 1024x768
Supporting Operating System Windows XP, Windows 7, Windows 8, Windows 10

Besides the components listed in the table above, your PC must be equipped with the following hardware and
software drivers:

e |nstalled Ethernet network card and installed driver

e One free 100 Mbps Ethernet port

1.3.2 Program installation
DLSentinel is a Datalogic safety laser scanner configuration tool providing several important advantages:
e Intuitive Graphical User Interface for rapid configuration;
e Defined configuration directly stored in the device;
e Discovery and IP address setting features to facilitate remote configuration
e Device Monitoring
To install DLSentinel:

1. On the PC that will be used for configuration, download the free setup file from the Datalogic website
(Laser Sentinel Download area > Software & Utilities):
http://www.datalogic.com/eng/products/manufacturing/safety/laser-sentinel-pd-829.html#download

2. Unzip the file and run the installation program by double-clicking the SetupDISentinel.msi file. The
downloaded folder also contains Windows framework (dotNetFx40 x86 x63.exe) provided by Datalogic in
case you need to update your operating system. Run the .msi setup file first, and only install the framework
.exe file if requested.

3. Follow the setup procedure and accept all terms and conditions required for this software release.

4. When the installation is complete, the DLSentinel entry is created in the Start > All Programs menu under
“Datalogic” along with a desktop icon.
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5. Before launching DLSentinel, you have to create the network LAN with the same address as the new
device. Follow the connection procedure described in par. 2.1.2.

Note: A dedicated computer running DLSentinel must be connected to a safety laser scanner through
the Ethernet port to perform the configuration and monitoring features.

1.4 DLSENTINEL USER INTERFACE

After launching DLSentinel to configure devices or handle reports, the DLSentinel Task Selection shows the
following main areas:

ft B

COATALOGIC

Help Task Selection

Getting Started
R——

New Safety System Configuration
eate a new fety tem Configuration

Modify Safety System Configuration From a Scanner on the Network

afety System Configuration From a Scanner on the Network

Monitor Safety System
Monitor a Scanner on the Network

ner on the Network

Read a Safety System Report from a

a Safety System Report from a Scan

Read a Safety System Report from PC
Show a Safety System Report from P

1. Main Menu and Toolbar Area — The DLSentinel main features.

2. Task Selection Area — Presents a list of the tasks that can be performed from DLSentinel. These
selections are also available in the File and the Scanner Menus (Main Menu Area).

3. Status Bar — A reserved area that keeps specific information about the connected device. It displays
information on the current network status, the connected device status, the connector and the application

type.

4. Help Online — A Help Guide that includes all the information and parameters to create a proper
configuration. For the next configuration steps, the help online is available/visible only by clicking on the

dedicated button ?

in the toolbar.
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1.4.1 Main menu

FILE
New Configuration To create a new Device Configuration.
Open Configuration from PC To open a previously saved Configuration on the local drive.

Read from PC:

— Report - Shows a Safety System Configuration Report saved on PC.
Save Saves the current configuration or report on PC.
Exit To exit the DLSentinel user interface.

SCANNER
Discovery Searches for a Device connected to the Network (LAN).
Direct Connect To connect to a Master device by entering its IP address.

Open Configuration from scanner  To open a configuration from a Device.
Open Shape from file To insert a previously saved shape in a zone.
Apply Configuration To apply a configuration to a connected Device.

Read from Scanner:

- Report - Shows a Safety System Configuration Report saved on PC.
Settings:

— Change Network Configuration

— Change Access Controls

— Reset Password

— Factory Reset
Update Firmware To update the Firmware file.
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OPTIONS

Change Language Allows the user to change the display language used for DLSentinel in
real time. The selected language will also be used for successive
sessions.

DLSentinel Log

— Extract Log
Report Settings

— Measure Unit

— System Coordinate

User’s Manual Opens the DLSentinel User's Manual.
Instruction Manual Opens the Laser Sentinel Instruction Manual.
About Opens a window that contains DLSentinel release version information.

1.4.2 Toolbar buttons

ICON DESCRIPTION

f

Getting Started: allows the user to start a session by clicking on one of the Task Selection options.

Save: saves the current configuration or report session.

sending it to the device. By clicking on this option, a validation test will be made on the entire
configuration in DLSentinel. A pop-up window will appear displaying either a list of configuration errors
or validating the configuration.

Monitoring: starts a monitoring session.

Help Online: displays a window that includes the help online guide and it shows the parameters

D Configuration Validator: this tool allows you to check the new configuration in DLSentinel before
? depending on the selected configuration step.
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1.4.3 Task selection

The right side of the main window includes the list of the Task selection. The list is explained in the chart below.

[e{0]\\ DESCRIPTION

New Safety System Configuration: to create a new Safety System Configuration on a Virtual
Scanner.

Open a Safety System Configuration from PC: to open and edit a Configuration saved on PC.

Modify Safety System Configuration from a Scanner on the Network: to edit a Safety
System Configuration from a Scanner on the Network.

Monitor Safety System: to enter the monitoring function of a connected Device.

sl |67 L 5

Read a Safety System Report from a Scanner on the Network: to view, print or save a Safety
System Configuration Report.

Read a Safety System Report from PC: to view or print a Safety System configuration report
stored on PC.
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1.5 LASER SENTINEL CONFIGURATION CHECKLIST

DLSentinel allows creating, testing and validating a device configuration. Complete configuration can only be
performed on a connected device (Online).

File Scanner Options Help - 0| x

=R OOVATALOGIC

Schino L
! SLS-M5-0812 — Configuration Programming Monitoring
M 958001040

Demo Settings
g SLS-R5 Configuration Settings

958001070 Application

Scenaric | EXPERT v Connector 12 PIN CONNECTION v

Configuration

Name -
Author vecreta
Description -
GUI Version
Safety Signature

Creation Date

Cluster

Name Test-Schino

Scanner

Name Schino

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

The main steps to configure the Laser Sentinel are:
1. CONFIGURATION: create the configuration through Settings, Outputs, Zone Set, Inputs, Detection, Zones.
2. PROGRAMMING: upload the configuration and generate the report file.
3. MONITORING: test and monitor the device functioning with the new configuration.

4. PROGRAMMING: validate the configuration (accept it or reject it).

indicating that the Laser Sentinel is waiting for configuration. You need to define a new configuration

f At first connection, the device has no pre-set configuration. The display shows the following icon
as described in chap. 2.

WAITING CONF
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2 LASER SENTINEL CONFIGURATION

2.1 ESTABLISHING ETHERNET COMMUNICATIONS WITH THE SCANNER

The first thing to do is connect the configuration PC to the Laser Sentinel scanner through the Ethernet port. There
are two different methods of establishing Ethernet communications with the Laser Sentinel depending on the
network restrictions of the plant in which it is installed.

If the plant provides an Ethernet network to which the Laser Sentinel is connected, then the Discovery feature can
be used by connecting the configuration PC to the network, as described in par. 2.1.1.

If there is no Ethernet network available or it is restricted, then the configuration PC must be connected point-to-
point with the Laser Sentinel and its IP address must be aligned to the Laser Sentinel default address to establish
communication, as described in par. 2.1.2.

with the factory default IP addresses, as described in par. 2.1.2. This is to avoid any network conflicts

f When connecting and using the device with your PC for the first time, use a point-to-point connection
in the Ethernet communication.
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2.1.1 DLSentinel Device Discovery through a Network

DLSentinel has a discovery feature to find the connected device.

1. Click on the Discovery item in the Scanner menu to search for the connected device. Alternatively, you
can select the Modify Safety Configuration item from the task menu.

Options Help
Discovery

Dirct Connect

=3

GOATALOGIC

Help l_-‘ Open configuration from Scanner
E| Ogen Shape from file
Gettin ij Apply configuration

e
[E Rehd from Scanner *

, Seftings »

g Uppiate Firmware

o

Click on the New Safety System Configuration to
advance to the Devife Selection page where you can
create a new configration from an offine device in the
Catalogue list.

Opening a Safety Sytem Configuration allows you to
load a previuosly safed configuration from the PC to
change it or upload § to the scanner via the Programming
item.

Click on Modify Safeffy System Configuration to Discover
your device on the e =

Task Selection |
D New safety system configuration

Create a new safely system configuration

Open a safety system configuration from PC
Edit a safety system configuration saved on PC

Modify safety system configuration from a Scanner on the network
Edit a safety system configuration from a Scanner on the network

?

Contextual Help is provided for each configuration step,
just dick on the help icon in the toolbar at the top. A
corresponding page of collapsed Help descriptions opens.
You can view the descriptions by dicking on the
parameter name with the @ icon.

For information about using DLSentingl GUI, refer to the
DLSentinel User's Manual. You can open it from the
Help menu or from the Windows Start menu under All
Programs >Datalogic>DLSentinel >x.x. x(sw version)
>Documentation.

=

For information about using the Laser Sentinel scanner
refer to the Laser Sentinel Instruction Manual. You
can open it from the Help menu or from the Windows
Start menu under Datalogic =DLSentinel>x.x x(sw
version) >Documentation.

Monitor safety system
Monitor a Scanner on the network

r on the netwqrk

Discovery: 33%

The User Interface opens and displays the device with its own default IP Address (192.168.0.10). Any other
device on the network will also be discovered.

File Scanner

Working

Options
ft B = 7

Discovery

Help =|lglx

GOATALOGIC

SLS-SA 150 h (1)
SLS-SA5
10.239.39.138
SLS-SA TEST
! SLS-SA5
10.239.39.138
Test-Schino
SLS-M5-0812
10.239.39.144

Slave no. 1

<

2. Click on the discovered device to place it in the Device Configuration panel. A warning message will be
displayed indicating that the device is not on the same network and prompts you to align it with the

network.
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WARNING
Scanner on a different Network, change its own IP
Address?

0K Cancel

3. Click OK and then change the IP Address parameters in the Network Configuration window to align them
with your network. Consult your network administrator for these parameters.

PLocal | . |
DHCP | Static o
P [0 . 239 . 39 . a4 |
subnet [ 255 . 255 0 o |
Gateway | 10 . 239 . 32 1]
IP Address used: 10.239.39.144 10.239.39.145 10.239.39.146 10
0K Cancel

A Laser Sentinel also reserves the successive |IP Address for internal functions.

4. Click OK to accept the new IP Address parameters. The device resets.
5. Click on the Discovery button. DLSentinel will rediscover the device with the new IP Address.

6. Click on the device to load it into the task area.

File Scanner Options Help

-lglx

o~
fBlr=? . $DATALOGIC
I — I
Next
Working ~
SLS-M5-0812 Test-Schino  FW:02.01.00.20  SLS M5 master 1
SLS-SA 150 h (1)
SLS-SAS = '] = staus @) PW:wWR 10.289.39.144
8 5
10.209.39136 SLS-R5 s0 SLS RS Slave o
SLS-SA TEST s0 10.238.39.146
g SLS-SA5 o
10.239.39.138
Test-Schino
SLS-M5-0812 .
10.239.39.144 %
Slave no. 1

7. Click on the white right-pointing arrow on the upper right side on the main panel to download the current
configuration from the device to the PC. DLSentinel is now connected to the device.

Note: If you are connecting the device for the first time or after a Factory Reset (see Factory Reset),
the display will show a “NO CONF” message until a new configuration is loaded.

Note: See par. 0 for modifying the current configuration or par. 2.5 for downloading a previously
saved configuration from the PC.
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2.1.2 Point-to-Point Configuration PC Static IP Addressing Alignment
It is possible to connect a configuration PC directly to the device using the Ethernet TCP/IP interface (point-to-
point).

When connecting and using the device with your PC for the first time, this procedure is
recommended to avoid any network conflicts in the Ethernet communication.

The Ethernet IP Addressing parameters must be aligned between the configuration PC and the scanner. Please
follow the procedure below.

The default Laser Sentinel static assignment Ethernet IP Address is: 192.168.0.10.

The successive IP Address (192.168.0.11) will also be reserved for internal functions.

1. Connect the device to the LAN port of your PC and switch it on.

2. Before changing the Ethernet network settings on the PC running the GUI, close any open applications that
use network resources (e.g. Outlook, Web browser).

3. On the configuration PC, from the Control Panel>Network and Internet>Network and Sharing Center, click
on the Local Area Connection link and open the properties window.

4. Select the Internet Protocol Version 4 (TCP/IPv4) item and open the properties window.

Set the IP Address fields as follows: 192.168.0.xx, where “xx” is any number differing from the device
address, and click OK to save. The PC is now aligned with the Laser Sentinel default network.

v Y
Internet Protocol Version 4 (TCP/IPv4) Properties li‘-ﬁ_ﬁ]

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(7) Obtain an IP address automatically

@) Use the following IP address:

IP address: 192 .168. 0 . 38
Subnet mask: 255.255.255. O
Default gateway:

Obtain DNS server address automatically
@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[]validate settings upon exit

[ OK ][ Cancel J
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6. Launch DLSentinel from the configuration PC.
7. Click on the Discovery button. DLSentinel will discover the device with the default IP Address.

8. Click on the device to load it into the task area.

ft B = 7 OVATALOGIC

Working N SLS-SAS Demo Settings ~ FW:02.00.00.79  SLS Stand Alone
Demo Settings / = status @) PW: WR 192.168.0.10

I SLS-SAS @
192.168.0.10

NOT CONNECTED

9. If Windows Firewall is active on the configuration PC, a pop-up window will appear after discovering the
device.

Note: If no firewall window appears, but an “Unable to connect” message is still shown, it may be due
to the antivirus firewall installed on you PC.

Do not close the pop-up window before allowing access to both private and public networks of the PC to
communicate and exchange data with the device through the Ethernet port.

@ Windows Security Alert by

Windows Defender Firewall has blocked some features of this

e

Windows Defender Firewall has blodked some features of DLSentinel on all public and private

networks,
Mame: DLSentinel
Publisher: Datalogic
Path: C:\program files (x56)\datalogicidlsentinel
42, 1.0dlsentinel. exe

Allow DLSentinel to communicate on these networks:
ri'-.rate networks, such as my home or work network

ublin: networks, such as those in airports and coffee shops (not recommended
because these networks often have lithe or no security)

What are the risks of alowing an app through a firewall?

B Allow access Cancel
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If you close the pop-up window before confirming the Firewall autl

horization, go to Control Panel>System

and Security>Windows Defender Firewall>Allowed apps and click on “Change settings”.

E Allowed apps

N @ > Control Panel > System and Security > Windows Defender Firewall > Allowed apps

Allow apps to communicate through Windows Defender Firewall
To add, change, or remove allowed apps and ports, click Change settings.

What are the risks of allowing an app to communicate?
@ For your security, some settings are managed by your system administrator.

Allowed apps and features:

Name Domain  Private  Public  Group Policy ™
[ Distributed Transaction Coordinator [m] ] ] No
W DL Sentinel No
Email and accounts Ne
[ Feedback Hub No
[ File and Printer Sharing m} m} Ne
[IFile and Printer Sharing over SMBDirect O O O N
[ Get Help No
™ Google Chrome No
[ Groove Music No
[ HomeGroup O m] m] No
[JiSCSI Service [m} O O N
M KD Service Port O 0 Ne L
Details... Remaove

- ] X

v | | Search Control Panel )

& Change settings

Allow another app...

OK Cancel

Scroll down the list and check the boxes on the DLSentinel row as shown in the figure below, then click

OK. The Firewall is now disabled on DLSentinel.

@ Allowed apps

A @ » ControlPanel » Systemand Security > Windows Defender Firewall > Allowed apps

Allow apps to communicate through Windows Defender Firewall
To add, change, or remeve allowed apps and ports, click Change settings.

What are the risks of allewing an app te communicate?
@ For your security, some settings are managed by your system administrator.

Allowed apps and features:

Mame Domain  Private  Publi

[ Distributed Transaction Coordinator ] 1 ]
DLSentinel i :

K
K

- [m] X

~|@ | Search Control Panel »p

) Change settings

¢ Group Policy ™

mail and accounts Mo
M Feedback Hub Ne
M File and Printer Sharing (] m] No
[JFile and Printer Sharing over SMBDirect ] m] O Na
[ Get Help No
M Google Chreme No
] Groove Music Mo
O HomeGroup =] [} =] No
OisCSl Service a ] a No
M KD Service Port: O ] Ne 57
Details... Remove

Allow anather app...

Cancel

Note: If you cannot find DLSentinel on the program list, uninstall and reinstall the software and follow
the procedure described in point 9.

10. Back on DLSentinel, click on the white right-pointing arrow on the upper right side on the main panel to
download the current configuration from the device to the PC. DLSentinel is now connected to the device.
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Note: If you are connecting the device for the first time or after a Factory Reset (see Factory Reset),
the display will show a “NO CONF” message until a new configuration is loaded.

Note: See par. 0 for modifying the current configuration or par. 2.5 for downloading a previously
saved configuration from the PC.
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2.2 MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE
NETWORK

1. Click on Modify Safety System Configuration From a Scanner on the Network task to edit a configuration
on a device on the Network (Online Configuration).

ODATALOGIC

Task Selection

Getting Started [\  New Safety System Configuration
— e o i B By Coa e
[j Open a Safety System Configuration From PC
dit a Satety System Configuration saved on F

Modify Safety System Configuration From a Scanner on the Network
Ean a Safety System Configuration From a Scanner on the Network

pering a Sak avn ad 4 prev @ Monitor Safety System
P e Monitor a Scanner on the Network
Read a Safety System Report from a Scanner on the Network
how a Safety System Report from a Scanner on the Network
?
. e o - l% Read a Safety System Report from PC
now a Safety System Report from P(

DLSentinel will enter Discovery mode to search for a connected device.

OOATALOGIC

ft B

Help

Task Selection
Getting Started New Safety System Configuration
e — cale & new Safily Sraten Contiaaralion

Optn a Salﬂy Sysum Configuration From PC
n saved on F

Modi rv SJ'.ly Sysum Conlq ration From a Scanner on the Network
1 the Network

@ Monitor Safety Symm
o
Read a Safety Symm R-pm
Discovery: 66%

Read a s:my Syslem R.pon

NOT CONNECTED

If the Laser Sentinel and the PC LAN are not aligned, it will be necessary to set the network
configuration settings. See par. 2.1.
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2. Click on the white right-pointing arrow on the upper right side on the main panel to download the current
configuration from the device to the PC. DLSentinel is now connected to the device.

Flle Scanner

f B & 7 ©DATALOGIC

Discovery )
Mext

Working -

SL5-M5-0B12 Test-Schino FW: 02.01.00.20 SL5 M5 masber \:}

SL5-SA 150 h (1)

i sLes4s 0 —
J

= 10.239.39.138

status ff PWwR 10.239.39.144

| -

5L5-RS . 50 5L5 RS Slave iF
|
| -]

SL5-3A TEST s0 10.239.29.146
SLE-SA5 I
10.239.39.138
Test-Schino
SL5-M5-0812
10.239.39.144 i
Slave no.

NOT CONNECTED
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2.2.1 Configuration Settings

The first page is the Configuration Settings page, which contains information about the application.

Help =)

File Scanner Options

ft B = ? OOATALOGIC

Schino L
! SLS-M5-0812 1 — Configuration Programming Monitoring
M 958001040
Demo Settings
! SLS-R5 [Configuraiion Settings ]
Sa8001070 — Application
Scenaric | EXPERT v Connector 12 PIN CONNECTION v

Configuration

Name -

Author |vcreta

Description —

GUI Version

Safety Signature

Creation Date

Cluster

Name Test-Schino

——J Scanner

Name Schino

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

e Scenario to select the configuration type (depending on the application).

— Vertical: Same as expert but requires that Reference Points be defined in the Zone
configuration (they are not optional for Vertical applications).

— Expert: provides the maximum configuration possibilities for the device. It contains the entire
set of parameters, regardless of the device use.

e Connector to select the connector type (depending on the device model and application).
— 8-pin connection: The configuration will manage the pins relative to this connector.

— 12-pin connection: The configuration will manage the pins relative to this connector (Master
only).
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==

ft B2 & ? GOATALOGIC

schino G
SLS-M5-0812 E Configuration Programming Monitoring

M 958001040

Demo Settings
SLS-R5 Configuration Settings
poranig Applicalion
[ Scenario | EXPERT ~ ] Connector | 12 PIN CONNECTION
8 PIN CONNECTION
Configuration 12 PIN CONNECTION
Name |—

Author vcreta

Description |—-

GUI Version

Safety Signature

Creation Date

Cluster

Name Test-Schino

Scanner

Name Schino

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

If you switch from 8 to 12-pin connection or vice versa after completing a configuration, the following
warning message will appear:

WARNING

Connector changed. All associated
pins will be deleted.

0K Cancel

In particular:

e If one single Zone was configured, its areas will be preserved, while all associated pins will
be deleted;

e If more than one Zone were configured, just the area of Zone 1 will be preserved, while all
other areas and associated pins will be deleted.

It is possible to view and edit some of the parameters in the Configuration section, such as:

¢ Name: A name to identify the configuration.
e Author: A name to identify the author.

o Description: A short text description to identify the configuration.
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e GUI Version: (Read-only). The software version of DLSentinel.

e Safety Signature: (Read-only). This is automatically generated to be a unique identifier that includes
the scanner, configuration, creation date and time.

e Creation Date: (Read-only). The date and time the configuration was created.
e Cluster: A name to identify the cluster.

e Scanner: A name to identify the scanner.
Note: To proceed with the configuration, click on the white right-pointing arrow on the upper right side
on the main panel. To go back to the previous page, click on the white left-pointing arrow.

2.2.2 Output Configuration

The Output Configuration displays the following parameters:

File Scanner Options Help || x

OOATALOGIC

— Configuration Programming Monitoring

(&) ) .
o= Output configuration
—3 Output functions —P Output signals
0s5sD | 1x2 Pin5 |OSSD12 Pink (PK)
Warning 1 v i
Pin7 WARNING 1 v Black (BK) [ ]
Alarm1 DISABLED v
Alarm2 DISABLED |+ Ping8 [0SSD 11 Gray (GY) --
Muting | DISABLED | v Pin9  NOFUNCTION v Red (RD) [ ] ]
Override Status DISABLED
Pin 10 NO FUNCTION v Violet (VT)

Muting Lamp |0
Pin 11 | NO FUNCTION | crayrink enek) [

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

Output Functions

e OSSD: to select the number of OSSD pairs to use for the configuration. This component is connected to
the machine control system and associated with the Safety Zone. If an object is detected in the Safety
Zone, the OSSD pair switches to the Off-State effectively shutting down the machine.

e 1x2 (One Pair) All OSSD outputs are managed in pairs, two pins (x2). OSSD 1/1 and 1/2 are
assigned Pin 5 and Pin 6 (8-pole model) or Pin 5 and Pin 8 (12-pole model).
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Warning: to select the number of Warning Zones to use for the configuration. This is the area outside the
Safety Zone where an object can be detected but the device will not switch to the Off-State. It can be used
to light a warning lamp or sound a siren.

Alarm 1: Enabling Alarm 1 activates the “Clean Window” device error warning.
Alarm 2: Enabling Alarm 2 activates the “Device Error” warning.

Muting: Enabling the Muting function allows the scanner to operate under controlled conditions where an
object can pass through the Safety Zone without the scanner switching to the Off-State. See the Laser
Sentinel Instruction Manual for more details on this feature. Dedicated devices must be connected to the
scanner input signals to control this function. An optional lamp can be connected to signal this condition.

Override Status: When the Muting function is enabled, enabling the Override input allows forcing the
safety function deactivation to clear the safety zone from a work cycle anomaly.

Muting Lamp: If the Muting function is enabled, an optional muting lamp can be connected to a scanner
output signal to indicate when the scanner is functioning in Muting (dangerous area temporarily
unprotected).

Note: Alarm 1 and 2 are only available when the M/S configuration is selected.

Output Signals

This parameter group assigns the signals of the output functions to the scanner pins. Each pin is also associated
with color-coded cable wiring, according to safety equipment regulations and standards.

The following pins are available for the 8-pin configuration:

Pin 1 (White Wire)

If a Warning Zone function is selected, this pin can be assigned as the Warning output. If a Muting Lamp is
selected (Muting function enabled), this pin can be assigned as the Muting Lamp output. If an Alarm is
enabled, this pin can be assigned to the Alarm 1 or Alarm 2 output (M/S configuration only). Otherwise, it
must be assigned here as No Function in order to be used as a Reset, Restart, Area Switch, Muting,
Muting Enable or Override input. See the Zone Set and Input configuration steps.

Pin 5 (Gray Wire)
This pin is automatically assigned to the safety output OSSD 1/1 (pair 1, output 1).

Pin 6 (Pink Wire)
This pin is automatically assigned to the safety output OSSD 1/2 (pair 1, output 2).

The following pins are available for the 12-pin configuration (M/S only):

Pin 5 (Pink Wire)
This pin is automatically assigned to the safety output OSSD 1/2 (pair 1, output 2).

Pin 7 (Black Wire)

If a Warning Zone function is selected, this pin can be assigned as the Warning output. If a Muting Lamp is
selected (Muting function enabled), this pin can be assigned as the Muting Lamp output. If an Alarm is
enabled, this pin can be assigned to the Alarm 1 or Alarm 2 output. If the Override status in enabled, this
pin can be assigned to the Override output. Otherwise, it must be assigned here as No Function in order to
be used as a Reset, Restart, Area Switch, Muting, Muting Enable or Override input. See the Zone Set and
Input configuration steps.

Pin 8 (Gray Wire)
This pin is automatically assigned to the safety output OSSD 1/1 (pair 1, output 1).
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Pin 9 (Red Wire)

If a Warning Zone function is selected, this pin can be assigned as the Warning output. If a Muting Lamp is
selected (Muting function enabled), this pin can be assigned as the Muting Lamp output. If an Alarm is
enabled, this pin can be assigned to the Alarm 1 or Alarm 2 output. If the Override status in enabled, this
pin can be assigned to the Override output. Otherwise, it must be assigned here as No Function in order to
be used as a Reset, Restart, Area Switch, Muting, Muting Enable or Override input. See the Zone Set and
Input configuration steps.

Pin 10 (Violet Wire)

If a Warning Zone function is selected, this pin can be assigned as the Warning output. If a Muting Lamp is
selected (Muting function enabled), this pin can be assigned as the Muting Lamp output. If an Alarm is
enabled, this pin can be assigned to the Alarm 1 or Alarm 2 output. If the Override status in enabled, this
pin can be assigned to the Override output. Otherwise, it must be assigned here as No Function in order to
be used as a Reset, Restart, Area Switch, Muting, Muting Enable or Override input. See the Zone Set and
Input configuration steps.

Pin 11 (Gray/Pink Wire)

If a Warning Zone function is selected, this pin can be assigned as the Warning output. If a Muting Lamp is
selected (Muting function enabled), this pin can be assigned as the Muting Lamp output. If an Alarm is
enabled, this pin can be assigned to the Alarm 1 or Alarm 2 output. If the Override status in enabled, this
pin can be assigned to the Override output. Otherwise, it must be assigned here as No Function in order to
be used as a Reset, Restart, Area Switch, Muting, Muting Enable or Override input. See the Zone Set and
Input configuration steps.
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2.2.3 Zone Set Configuration

Zone Set Configuration displays the following parameters:

File Scanner Options

— Configuration

— Zone Sets
ZoneSet No. 2

mol
X zone I
[0 Zone Set1

[ Zone Set2

CONNECTED 12 PIN CONNECTION

Programming

EXPERT

Monitoring

[ Zone Set configuration ]

~
Z  Input Delay Max [msec] 30

— Input signals
Area Switch1 Area Switch2 RISy AREASWICHY

1] 1]
Pin7 |[WARNING 1

0 0 Pin 9 |AREA SWITCH 2

Pin 10 NO FUNCTION

Pin 11  NO FUNCTION

SCANNER STATUS: WORKING

DEVICE IP: 10.239.39.144

=G| x

GOATALOGIC

v White (WH)

Black (BK)
v Red (RD)
v Violet (VT)

v crayrink envek) [N

A Zone Set defines the area within the Laser Sentinel operating range to be monitored (Safety Zone, and if
present, Warning Zone). More than one Zone Set can be configured to define either separate or overlapping areas
and these can be switched alternatively using combinations of input signal states.

Zone Set Parameters

e Zone Set No.: to select the number of Zone Sets to use for the configuration. The default value is one
Zone Set (no Area Switching). By pressing the up arrow more Zone Sets can be added. Please note that
you can select max. 10 Zone Sets with the 12-pole Master Slave model, max. 3 Zone Sets with the 8-pole
Master Slave model, and max. 6 Zone Sets with the Stand Alone model.

e Input Delay Max [msec]

This parameter is valid when there are at least two Zone Sets. It determines the delay to apply between
switching from one Zone Set to the next. The input delay allows waiting for the Area Switching inputs to
stabilize from their transient states before accepting the Zone Set. Otherwise the activation and
deactivation of the inputs could put the device in undesired or invalid and temporary switching zone input
combinations and therefore cause the device to enter the fault state.
The minimum input delay (default) value is 30 msec. It can be increased in 30 msec increments.

e Zone

This parameter group allows editing the Area Switch input combinations depending on the number of

selected Zone Sets.
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By selecting more than one Zone Set in the Zone Set No. parameter, a number of Area Switches (AS#)
equal to the number of unassigned inputs will appear in the graphic.

It is possible to set the input switch coding with specific buttons. See the table below:

X By selecting a Zone Set through the checkbox and clicking on this button, the Zone Set will be removed.
1@ | By clicking on this button, the Zone Set Combination will be automatically set.
+ | By clicking this button, the created combination will be verified.

Alternatively, you can click inside the AS box to manually change its state. All Area Switching must differ by two
input bit states to be valid.

Input Signals

This parameter group assigns the signals of the input functions to the scanner pins. Each pin is also associated
with color-coded cable wiring, according to safety equipment regulations and standards.

The following pins are available for the 8-pin configuration:

Pin 1 (White Wire)

If this pin has been assigned as a Warning, Alarm or Muting Lamp output, it is not available (shown in
gray). If it hasn’t been assigned to any output, it can be assigned here as an Area Switch input. Selecting
No Function here allows it to be assigned to one of the Muting input signals or the Muting Enable signal,
the Muting Override input signal or as a manual Restart and/or Reset input (see the Input configuration
step in par. 2.2.4). If this input is not used, select No Function.

Pin 3 (Green Wire)

This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input. See the Input configuration step. If this input is not used, select No
Function.

Pin 4 (Yellow Wire)

This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input. See the Input configuration step. If this input is not used, select No
Function.

The following pins are available for the 12-pin configuration:

Pin 3 (White Wire)
This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.

Pin 7 (Black Wire)

If this pin has been assigned as a Warning, Alarm or Muting Lamp output, it is not available (shown in
gray). If it hasn’t been assigned to any output, it can be assigned here as an Area Switch input. Selecting
No Function here allows it to be assigned to one of the Muting input signals or the Muting Enable signal,
the Muting Override input signal or as a manual Restart and/or Reset input (see the Input configuration
step in par. 2.2.4). If this input is not used, select No Function.

Pin 9 (Red Wire)

This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.
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e Pin 10 (Violet Wire)
This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.

e Pin 11 (Gray/Pink Wire)
This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.

Zone Sets configuration example:

e If the configuration includes only one Zone Set, there is no area switching, so it is not necessary to assign
any input to an area switch.

=T x

nnnnnn

4
COATALOGIC
- “
- — Configuration Programming Monitoring ( >
3 Back Next
[ ] " )
] Zone Set configuration
—> Zone Sets
ZoneSet No. 1 e
X zone fif} J —P Input signals
i
Pin2  NO FUNCTION v White (WH)
] Zone set1
Pin7 WARNING 1 Black (BK) [ ]
Pin8 | NO FUNCTION v Red (RD) | |
Pin 10 | NO FUNCTION v Violet (VT)
Pin 11  NO FUNCTION v crayrinkevek) [
CONNECTED 12PIN CONNECTION | EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144
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e If two Zone Sets are selected, Area Switching is required, and so two inputs must be assigned to the area
switch functions (AREA SWITCH 1, AREA SWITCH 2).

=|3x

GOATALOGIC

File Scanner Options Help

- — Configuration Programming Monitoring
[ ) ) )
=] Zone Set configuration
—Pp Zone Sets
ZoneSet No. 2 2 Input Delay Max [msec] 30 =
X zone 788 ‘, — Input signals
i
Area Switch1 Area Switch? Bini3[AREAISWITCHT hd White (WH)
[0 Zone set1 0 ]
Pin7 |WARNING Black (BK) | ] ]
W] EIREE 0 0 Pin8  AREA SWITCH2 v Red (RD) [ ||
Pin 10 NO FUNCTION v Violet (VT)
Pin11 | NO FUNCTION ~ cryrnkenes) [

CONNECTED 12 PIN CONNECTION EXPERT ‘SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

e If six Zone Sets are selected (in this case the Warning function is not available):

= for the 8-pin configuration, Pins 1, 3 and 4 must all be assigned to the Area Switch functions

(AREA SWITCH 1, AREA SWITCH 2 and AREA SWITCH 3).
= for the 12-pin configuration, three pins must be assigned to the Area Switch functions (AREA

SWITCH 1, AREA SWITCH 2 and AREA SWITCH 3).

SDATALOGIC

. - . n3 |AREA SWITCH1 White b
menswicnz v eeceo [N
measwrons v reewor (NN
Zone set 0 e 1 o Pin10 AREA SMITCH 4 v ()
Zone 50t 0 1 1 . Pin 11| NO FUNCTION cayrik iowrx) [

Pag. 33/75



DLSENTINEL

SOATALOGIC

If ten Zone Sets are selected (12-pin configuration only, the Warning function is not available), Pins 3, 7, 9,

10 and 11 must all be assigned to the Area Switch functions (AREA SWITCH 1, AREA SWITCH 2, AREA

SWITCH 3, AREA SWITCH 4 and AREA SWITCH 5).

©DATALOGIC

X e i

Zone Set configuration

Pin3 | AREA SWITCH1 v White

in7 | AREA SWTTCHZ v

PinS | AREA SWITCH3

WH)

Black (BK)

Pin 10 | AREA SWITCH 4 v Violet (V1)

1 | AREA SWITCH 5

X zone et J
10

If more Zone Sets are selected, make sure to create a valid input coding combination: the Zone Sets
must differ by two input bit states with respect to any other Zone Set. Otherwise, by clicking on the
validation button a pop-up window that shows the coding validation error will be displayed.

Area Switch1 Area Switch2 Area Switch3

[0 Zone Set1 0 0 :
[0 Zone Set2 0 1 3

[0 Zone Set3 Coding Validation
[0 Zone Set4 A Coding not binomial
[0 Zone Set5 o

[0 Zone Set§ 1 0 5
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2.2.4 Input Configuration

The Input Configuration displays the following parameters:

©DATALOGIC

nput configuration
—P satety Zone P Find NOFUNCTION v White (WH
estart mode AUTOMATIC v
Pin7 [WARNIN Black (BK) | [ ]
200 ol
Fin®  NOFUNCTION - Red (RD) | [ ]
PIn 10 NO FUNCTION v Violet (VT
Pin11 | NO FUNCTION ~| erayrink onek) [

CONNECTED 12 PIN CONNECTION  EXPERT SCANNER STATUS: WORKING SCANNER IP: 10.239.39.154

Input Functions

e Restart Mode: For each Safety Zone you can select the restart mode.

— Automatic: The Laser Sentinel automatically returns the OSSD pair to the On-State after all
detected objects are removed from the Safety Zone and the configured Recovery Time
elapses.

— Manual: The Laser Sentinel returns the OSSD pair to the On-State after all detected objects
are removed from the Safety Zone and a manual Restart switch (push-button) is pressed for at
least 500 msec. If the Restart switch is pressed while an object is still inside the Safety Zone,
the Laser Sentinel switches to a failure lockout state and must be Reset.

e Recovery time: This parameter is only significant for Automatic Restart Mode. The recovery time is
the time between the object removal from the Safety Zone and the OSSDs achieving the On-State.
Select the time to elapse before the OSSD pair returns to the On-State. The minimum Recovery Time
is 200 msec. This can be increased to 60000 msec in 1 msec increments.

e Muting Type: The Muting function can be used in two different configurations:

— Unidirectional: This is when objects can pass through the Safety Zone from only one
direction. It requires two Muting sensors be connected to the Laser Sentinel inputs.

— Bidirectional: This is when objects can pass through the Safety Zone from both
directions. It requires four Muting sensors be connected to the Laser Sentinel inputs.

e M coeff.: For Unidirectional Muting, the M coefficient is the delay multiplier that causes the Muting function
to end. This is the multiplier of the activation delay between the two sensors. It can be set from 2 to 16.

e Max Muting Activation Delay: This is the maximum delay between the Muting sensors activation that will
still allow the Muting function to be enabled. If the second Muting sensor is activated after this max. delay,
the Laser Sentinel will not enter Muting.
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Timeout: This defines the maximum duration for the Muting function regardless of the Muting sensors
state. The values range from 10 to 1080 minutes. If set to 0, the Muting function is indefinite. This means
that Muting will continue as long as the Muting conditions exist.

Attention: User is warned that the latter setting is not compliant with IEC 61496-1.

Override: When the Muting function is enabled, enabling the Override input allows forcing the safety
function deactivation to clear the safety zone from a work cycle anomaly.

Override Mode: The available override modes are single line pattern, edge and trigger. See the Laser
Sentinel Instruction Manual for details.

Input Signals

This parameter group assigns the signals of the input functions to the scanner pins. Each pin is also associated
with color-coded cable wiring, according to safety equipment regulations and standards.

The following pins are available for the 8-pin configuration:

Pin 1 (White Wire)

If this pin has been assigned as a Warning, Alarm or Muting Lamp output, it is not available (shown in
gray). If it hasn’t been assigned to any output, it can be assigned here as an Area Switch input. Selecting
No Function here allows it to be assigned to one of the Muting input signals or the Muting Enable signal,
the Muting Override input signal or as a manual Restart and/or Reset input (see the Input configuration
step in par. 2.2.4). If this input is not used, select No Function.

Pin 3 (Green Wire)

This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input. See the Input configuration step. If this input is not used, select No
Function.

Pin 4 (Yellow Wire)

This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input. See the Input configuration step. If this input is not used, select No
Function.

The following pins are available for the 12-pin configuration:

Pin 3 (White Wire)
This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.

Pin 7 (Black Wire)

If this pin has been assigned as a Warning, Alarm or Muting Lamp output, it is not available (shown in
gray). If it hasn’t been assigned to any output, it can be assigned here as an Area Switch input. Selecting
No Function here allows it to be assigned to one of the Muting input signals or the Muting Enable signal,
the Muting Override input signal or as a manual Restart and/or Reset input (see the Input configuration
step in par. 2.2.4). If this input is not used, select No Function.

Pin 9 (Red Wire)

This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.

Pin 10 (Violet Wire)
This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
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manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.

e Pin 11 (Gray/Pink Wire)
This pin can be assigned here as an Area Switch input. Selecting No Function here allows it to be assigned
to one of the Muting input signals or the Muting Enable signal, the Muting Override input signal or as a
manual Restart and/or Reset input (see the Input configuration step in par. 2.2.4). If this input is not used,
select No Function.
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2.2.5 Detection Configuration

The Detection Configuration displays the following parameters:

File Scanner Options Help
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GOATALOGIC

Schino 4
! SLS-M5-0812 = configuration  Programming

M 958001040 5

Demo Settings
g SLs-R5

SEB001070 —> Response time
Detection
—J safety Zone
Number of Scans
2 v
Response time [msec]
72
Detection capability [mm]
70 v
Dust Filter Level
Low YN
5500
5500
A

CONNECTED 12 PIN CONNECTION EXPERT

Detection Parameters

SCANNER STATUS: WORKING

Detection configuration

Worst Cluster response time [msec]
72

DEVICE IP: 10.239.39.144

—J Warning Zone 1

Number of Scans
2 v

Response time [msec]
72
Detection capability [mm]
70 v
Dust Filter Level
Low VoA

50000

40000

Number of Scans: Select the number of scans required to validate detection. This parameter has
a direct impact on the Response Time, which is the time from when an object is detected in the
Safety Zone to when the OSSD switches to the OFF-State.

The Number of Scans determines the Response Time, which ranges from 62 to 482 ms in 30 ms
increments.

Detection Capability: The ability to detect an object of given dimensions within the detection
zone. The detection capability for these models is either 40 mm or 70 mm. Objects greater than or
equal to the selected value can be detected both for the Safety and Warning Zones.

Dust Filter Level must be set according to different conditions specific to the application. In
general, it is the sensibility to various levels of airborne particles that impact the response of the
Laser Sentinel detection.

— High Dust Filter Level is used in dirty environments to filter (ignore) detection of airborne
particles from being confused with objects to detect. The Laser Sentinel is less sensitive to
dust and therefore avoids shutting down the machinery unnecessarily.

- Mid

— Low Dust Filter Level is used in cleaner environments where airborne particles have little
effect on object detection.

Dust Filter Level should be set to the lowest value that still allows the machinery to work without detections due to

dust.
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Note: In addition to the level of airborne particles in the Laser Sentinel environment, some special
lighting conditions also affect the detection sensibility. These conditions are:

¢ high reflective backgrounds within 3 meters of the Safety Zone boundary

o the presence of bright light within +/- 5° of the detection plane.

The additional distance must be included in the Minimum Safety Distance calculations for

these cases.

See the graphs in the Laser Sentinel Instruction Manual for these additional distances.

File Scanner Options Help
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Demo Settings
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Response time [msec]
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Dust Filter Level
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CONNECTED 12 PIN CONNECTION EXPERT

Monitoring

Detection configuration

Worst Cluster response time [msec]

SCANNER STATUS: WORKING

72

DEVICE IP: 10.239.39.144

COATALOGIC

>

Back Next

Warning Zone 1
Number of Scans

2 v
Response time [msec]
72
Detection capability [mm]
70 v
Dust Filter Level

Low v A

50000

40000

Note: The response time of the Cluster corresponds to the response time of the safety output of the
device that goes into STOP and the network latency time. If the device in STOP is the master, no
latency must be added; if the slaves are in STOP, then the latency time must be added to each device
response time.
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2.2.6 Zones Configuration

In the Zones Configuration, tools are provided to draw the Safety and Warning Zones as well as Reference
Points. It is possible to select different shapes and different functions to manage the areas on the graph.

The panel on the left side allows selecting the areas to handle on the graph (Safety, Warning, or Reference Points)
and managing them individually. See the paragraph on Selecting and Visualizing Areas on the Graph.
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Note: This is the last step in defining the configuration. To complete configuration (load it onto the
scanner, test it and Accept it), see Programming and Monitoring in chapter Programming and
Monitoring Functions.
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DESCRIPTION

Click this button to free-hand draw an area by holding pressed the left button of the mouse and
dragging it across the graph. Once finished, release the left button.
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DESCRIPTION

Click this button to draw a straight-edged area by holding pressed the left button of the mouse and
dragging it across the graph. Once finished, release the left button.
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DESCRIPTION

Click this button to draw a circle shaped area with its center at the scanner by holding pressed the
left button of the mouse and dragging it across the graph. Once finished, release the left button.
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DESCRIPTION

Click this button to draw an arc shaped area by holding pressed the left button of the mouse and
dragging it across the graph. Once finished, release the left button.
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DESCRIPTION

point in the graph and drag the mouse to draw the area. Left-click again to start the next edge of

I Click this button to draw a polygon shaped area. Left-click and release the mouse button on a
the polygon area. Once finished, double-click the left button.
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DESCRIPTION

—‘u Click this button to draw Reference Points.
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Note: To activate this function, select the REFERENCE POINT area on the left pane.

Specify the distance tolerance of the reference point from the scanner along the ray (+= farther from the scanner, -
= closer to the scanner).

There must be a minimum of 3 and a maximum of 15 Reference Points. Reference points monitoring is a safety
function used to monitor any change in position of the scanner, a protective structure or a moving structure located
at the specified reference point. These structures either allow or prevent access to the dangerous area and are
therefore outside the monitored Safety Zone. When the device detects a change in position at the Reference Points
exceeding the specified tolerance, the OSSD goes to the OFF-state. This function is required for Vertical
applications. See the Laser Sentinel manual for more details.
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DESCRIPTION

{x } Click this button to draw an area by selecting the type of shape (circle, arc or polygon) and directly
Y inserting the measurements and coordinates.
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Editing Drawn Objects

Once the area has been drawn, it is possible to access an edit menu by right-clicking on the selected area. This
menu allows:

copying a drawn object between Warning and Safety of the same Zone
moving a drawn object between Warning and Safety of the same Zone
saving a drawn object

editing a drawn object

deleting a drawn object
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DESCRIPTION

Click this button to move (drag) the graph in any direction. Once finished, re-click on the button.
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DESCRIPTION

inch | click this button to toggle the graph unit of measurement between inches and millimeters.
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DESCRIPTION

Click this button to zoom in on the graph. Clicking multiple times continues to zoom in.

Fie  Scaner  Opfions =[x
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DESCRIPTION

Click this button to zoom out on the graph. Clicking multiple times continues to zoom out.

Fie  Scaner  Options  Help =|lalx
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DESCRIPTION

Click this button to toggle the graph coordinates between Cartesian and Polar.
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DESCRIPTION

@ Click this button to show the area points and edit them. Once finished, re-click on the button.

File Scanner Options
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DESCRIPTION

Click this button to enter the Teach In feature. This function scans and shows the area surrounding
the device. It displays a white area that is free from obstacles and therefore can be assigned to a
safety or a warning zone. The grey areas are detected obstructions.

File Scanner Options Help =0 X
# B w7 GUATALOGIC
Demo Settings.
SLS-M5-0812
M 958001040
Demo Settings
SLSR5 Zones configuration » /7
HEEEEEEEEEEEE.
L] v
\J
]
-
Doyt
+
inch
oy
'CONFIGURATION g
4 ZONES ET B
4 Zonet
[ satety (<3
O REE Rvg:rgé"g:um @

EERRREY~
L] e NN
HEEEERNaN N [ [ L[] []

IIIIIIII/' A ]
T
:

5%

X = -8845.00 mm Y = 6583.40 mm

Pag. 55/75



DLSENTINEL GOATALOGIC

DESCRIPTION

This function is the Teach In Area Assignment, to assign a zone type to the detected white area. After
@ choosing Teach In, select the checkbox of either the safety zone or warning zone in the left pane and
then click this button to assign it.

File ‘Scanner Options Help =1@|x
N B 7 SIATALOGIC
Demo Settings
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A Teach In and Draw Teach in Zone are only available if the device is online.

Pag. 56/75



DLSENTINEL <= DAtALOCIIC

Selecting and Visualizing Areas on the Graph

The panel on the left side allows selecting the areas to handle on the graph (Safety, Warning, or Reference Points)
and managing them individually.

Fle  Scanmer  Options —|o|x
L= I GOATALOGIC
: w
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By clicking on the label name (outside the check box), it is possible to highlight a specific area, e.g. a Safety Zone
or a Warning Zone.

By clicking on the checkbox, it is possible to select and edit a specific area.
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The combination of these selections allows you to show/hide the areas together or individually.

File Scanner Options

-lalIx
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Note: This is the last step in defining the configuration. To complete configuration (load it onto the
scanner, test it and Accept it), see Programming and Monitoring in chapter 4.
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2.3 NEW CONFIGURATION SELECTION

1. Click on the New Configuration task to create a new configuration and save it on a local PC for upload to a
device at a later time (Offline Configuration).

File Scanner Options

# Bl B ?
Help

Getting Started

Ciick on the liew Safety System Configuration to
advance to the Device Selection page where you car

election page where you can
@eate anew configuration from an offine device in the
Catalogue fst

afety System Configuration allows you to
q configuration f

saved configt
ad it to the scanner via the Programming

Ciick on Moy Safety System Configuration to Discover
your device on the LAN and change its configuration.

DlSentinel GUI, refer to the
u can m the

tart Al
Programs >Datalogic>DL Sentinel>x.x. x(sw version)
>Documentation.

&

For information about using the Laser Senti
refer to t |

File

#ft B

Oplions  Help

Catalogue
@ scanner

SL5-5A-5

B susmsoen
=

(@ siave

l SLS-RS

Q

(-
F
P
%
)

Task Selection

New safety system configuration
Create a new safety system configuration

Open a safety system configuration from PC

Edit a safety system configuration saved on PC

Modify safety system configuration from a Scanner on the network
Edit a safety system configuration from a Scanner on the network

Monitor safety system
Monitor a Scanner on the network

Read a safety system report from a Scanner on the network
Show a safety system report from a Scanner on the network

Read a safety system report from PC
Show a safety system report from PC

CLICK ON DEVICE TO CREATE A NEW CONFIGURATION

=31

SOATALOGIC

=133

SGODATALOGIC

NOT CONNECTED

3. Click on the white right-pointing arrow on the upper right side on the main panel to open the offline
configuration. You can now create your configuration and save it on your PC. See the subparagraphs
under par. 0 for configuration details.

4. Save the configuration on a file on your PC. See par. 2.4.
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2.4 SAVE THE CONFIGURATION

Once the configuration is done, it is possible to save it on the PC by clicking on File > Save.

Scanner Options
New configuration
Open configuration from PC

Read from PC

Save

-loIx

GOATALOGIC

Programmi
Back
Demo Settings
SLS-R5 Zones configuration » 7
958001070 o0 AN
o0 v
500 L ]
om0
)
2000 £
2000 inch
1000 Q
4 CONFIGURATION
4 ZONESET
4 Zonet
Lo
2000 .\\
Laoo
Lo
Lsoo0
Looco
SRR a0 a0 200 000 om0 000 B0 00 60 0D 4000 000 200 1000 W0 A0 W0 400 00 00 700 G0 G0 10000 MO0 2000 100 4000 15
X = 5210.00 mm Y =7323.40 mm 5%

NOT CONNECTED 12PINCONNECTION | EXPERT
Save
« v &[> ThisPC > Deskiop » new vo
Organize v New folder
3 This b A MName - Date modified
dm

Mo items match your search,
9 3D Objects

29 Desktop
5] Documents
¥ Downloads.
B Music

=] Pictures
B Videos

Local Disk (C:)

= grpfiles (itesr.

Zones configuration

=|alx

COATALOGIC

/
N
[ ]
\/
L ]
-+

= difs (Wdlnet) (LY € >
File name: | Configuration_2018-10-18T15-30- 200l v o
Save astype: | MB fles Caml) S +
inch
~ Hide Folders Cancel
1000
4 CONFIGURATION
4 ZONESET
|
1000 /
SArc- / @
[JREFERENCE POINT /
2000 \
2000
om0
000
om0
W% a0 w0 2000 00 0000 900 8000 000 6000  SO00 400 B000 2000 -1000 100 000 300 400 00 e0 7000 00 00 10000 1900 12000 13000 M0 15
X=-11370.00 mm Y =7183.40 mm 5%
NOT CONNECTED 12 PIN CONNECTION | EXPERT

Pag. 60/75



DLSENTINEL

SOATALOGIC

2.5 OPEN A PREVIOUSLY SAVED SAFETY SYSTEM CONFIGURATION FROM PC

1. Click on the Open a Safety System Configuration from PC task to open and upload a previously saved

configuration onto a device.

File Scanner

Options

=gl

GOATALOGIC

< Show A

7 @
= -
(3

Bd

Ciick on the New Safety System Configuration o
advance to the Device Selection page where you can
eate anew configuration from an offline device in the
Catslogue ist.

Opening a Safety System Configuration alows you to

load  previuosly saved configuration from the PC to
change it o upload it to the scanner via the Programrming
item.

Ciick on Modify Safety System Confiquration to Discover
Your device on the LAN and change its configuration,

? 85

Contextual Hep is provided for each configuration step,
just cick on the help icon in the toolbar at the top. A
corresponding page of collapsed Help descriptions opers.
You can view the descriptions by dicking on the
parameter name with the @ icon

For information about using DLSentinel GLI, refer to the
DlSentinel User's Manual an open it from the
Hielp menu or from the Windows Start menu under Al
Programs >DatalogicDLSentinel>x x. x(sw version)
>Documentation.

8]

Far information about using the Laser Sentinel scanner
refer to the Laser Sentinel Instruction Manual. You
can open it from the Help menu or from the Windows
Start menu under Datalogic>DLSentinel .. x(sw
version) »Documentation,

Task Selection ‘

New safety system configuration
Create a new safety system configuration

Open a safety system configuration from PC
Edit a safety system configuration saved on PC

Modify safety system configuration from a Scanner on the network
Edit a safety system configuration from a Scanner on the network

Monitor safety system
Monitor a Scanner on the network

Read a safety system report from a Scanner on the network
Show a safely system report from a Scanner on the network

Read a safety system report from PC
Show a safety system report from PC

2. Select the Configuration File to open.

Open
4 [ > ThisPC » Documents » SLS -
Organize = New folder
0 This pC | e :

1 3D Objects
[ Desktop

5 Documents
& Downloads
D Music

=] Pictures
[ Videos

‘i Local Disk (C)

= grpfiles (itasry
= difs (dllnet) (L
= pubfiles (\itasry

¥ Network
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Date modified Type
< match your search P
@ation
tion from PC
ved on PC

lion from a Scanner on the network
im a Scanner on the network

M a Scanner on the network

Cancel Bcanner on the network

? &

Contextual Helpis provided for each configuration step,
Just click on the help icon i the toolbar at the top. A
eorresponding page of collapsed Help descriptons apen.

wu can view the descriptions by dicking an the
parameter name with the & icon,

For information about Using DLSentinel GUL, refer to the
DLSentinel User's Manual. You can open it from the
Help menu or from the Windows Start menu under Al
Programs >Datalogic>DL Sentinel >x x.x(sw version)
>Documentation.

For nformation about usng the Laser Sentnel scanner

r<fe o he Laser Sentinel Instruction Hor
can open it from the Help menu or
St e Datsloie Dl Sentnelas x X
version) >Documentation,

Read a safety system report from PC
‘Show a safety system report from PC
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3. Once the configuration is open, click on the Programming item. The Discovery procedure will discover the
connected device.

=|0|x

# B - SOATALOGIC

Schino e
B s P —
M 958001040

Demo Settings
! SLS-RS Configuration Settings

858001070

Application
Scenario  EXPERT v Connector | 12 PIN CONNECTION v

Configuration

Name —

Author vereta

Description —

GUI Version

Safety Signature

Creation Date

Cluster

Name Test-Schino

Scanner

Name Schino

NOT CONNECTED 12 PIN CONNECTION | EXPERT

4. Click on the device to load it into the task area.

File

#f Bz

Scanner  Opfians

Help

COATALOGIC

Discovery
Working -
SLS-M5-0812 Test-Schino  FW:02.01.00.20  SLS M5 master 17
SLS-SA TEST l
! SLE-8A5 o M m @ Pewr 10.209.99.144
10.238.39.138 .
SLS-RS ' s0 SLS RS Slave 9
Test-Schino s0 = 10.239.39.146
SLS-M5-0812
[ Jytgin
Stave no. 1

NOT CONNECTED
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5. Click on the white right-pointing arrow on the upper right side on the main panel. The Programming page
will appear. Here you can Load the selected configuration to the scanner.

nnnnnn Options =lalx

COATALOGIC

Programming

Configuration Upload B QQ C

$DATALOCIC
Laser Sentinel

& 1 ey

CONNECTED 12PINCONNECTION | EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

First the configuration will be validated and then you will be prompted to enter the password to change the
current configuration to the new one.

6. Enter the password and click OK.

=133

SGODATALOGIC

B
= Programming

Configuration Upload B QQC

GOATALOGIC
Laser Sentinel

12PINCONNECTION  EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

7. The scanner status will now switch to Off-Duty and the user is prompted to continue to load the new
configuration onto the scanner.
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File Scanner Options =] x

CDATALOGIC

- Programming  Monitoring
Next

[} "
- Programming

Configuration upload Ba QQ (&

CDATALOGIC
Laser Sentinel

Summary

WARNING

A Scanner status change in Off-Duty.
Continue?

Load

£ of 7 >

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING SCANNER IP: 10.239.39.154

8. Click on the Monitoring item to verify the configuration. See par. 3.2.

9. Then click on Programming to Accept the new configuration and finalize it. See par. 3.1.
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3 PROGRAMMING AND MONITORING FUNCTIONS

3.1 PROGRAMMING

Programming is a DLSentinel function that allows uploading a configuration to the device, generating the Safety
Report and validating the uploaded configuration (after testing it through the Monitoring function, refer to par. 3.2).

The steps below show a proper Programming procedure:
1. Once the configuration has been created or loaded from the PC, enter the Programming function.

A Report file is generated by DLSentinel.

-lolx

COATALOGIC

Programming

Configuration Upload

Be Qalc

GDATALOGIC
Laser Sentinel

Summary

Load

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

The Safety Report is a file that sums up all the parameters selected for a configuration and is generated by
DLSentinel after uploading a configuration. The Report file is displayed on the right side of the panel. It is
possible to save it as a PDF file and print it.

Make sure to read the Safety Report and check all the selected parameters.
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=3 x

COATALOCGIC

Fie  Scanner Options Help

[
) — comeuss . o
= Configuration Programming  Monitoring

B o
Programming

Configuration Upload B& QQ C

COATALOCIC

Laser Sentinel

Load

SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144

12 PIN CONNECTION EXPERT

CONNECTED

@ Note: The Safety Report displays the new and the previously used parameters (marked in red).

In the Configuration Upload section, click on the Load button to upload the configuration from the PC to
the device. First the configuration will be validated and then you will be prompted to enter the password to

change the current configuration to the new one.

2.

=T x

GOATALOGIC

F=Y “
- — Configuration Programming Monitoring ( )
Back Next
[ ] .
] Programming
Configuration Upload g Q QQ c

SDATALOGIC
Laser Sentinel

Summary

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.39.144
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While uploading the configuration onto the device, Laser Sentinel will enter the Off status.

Once the new configuration is uploaded, Laser Sentinel will display an icon with a white background like
the one below indicating that the configuration is pending acceptance by the user.

GO

Example Pending Configuration Acceptance Icon displayed
3. Test the configuration functioning by entering Monitoring. See par. 3.2.

4. After testing it and checking the Report, Accept or Reject the configuration in the Validation section.

=3]x

SGOATALOGIC

=
=) Programming

Configuration Upload
onfiguration Uploa Be Yo,

SDATALOGIC
Laser Sentinel

Summary

Configuration validator

The configuration was successful
validated

oK

Load

< 1 a7 )

CONNECTED 12 PIN CONNECTION EXPERT SCANNER STATUS: WORKING DEVICE IP: 10.239.30.144

After Acceptance, the configuration will be finalized on the device. Laser Sentinel will display an icon with
a black background like the one below indicating that the configuration has been accepted by the user.

GO

Configuration Accepted Icon displayed

By validating the configuration, you take on responsibility for the created configuration and accept any
hazards due to configuration errors.

If you Reject the new configuration, the previous configuration will be finalized on the scanner.

A\
A
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3.2 MONITORING

Monitoring is a DLSentinel function that allows you to check the proper functioning of the created configuration by
monitoring the current working area. You have access to this function only by selecting an online device.

-lolx

A B = 7 GOATALOGIC
Sching L]

. SLS-M5-0812
M 958001040

Demo Settings
SLS-RS

958001070 I
N

PRy 4D

WARNING

Zoneset1-

@ osso1
Q wami1

With the Monitoring function, the following information can be checked:

e The OSSDs GO/STOP status.

e The connector pin assignment, colors and functions.

e If the Laser Sentinel detects an object in the Safety and Warning zones.
e Any diagnostic errors that caused the OSSDs Off status.

e The surrounding space detected by the device in real time.

e The switching among the Zone Sets.

e The selected Parameters
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On the panel at the lower left corner, DLSentinel shows the device status (if it is correctly
functioning). It is also possible to view some parameters, e.g. the pin assignment and the
response time.

Zoneset 1 -

@ ossp1
@ warn1

Connector Diagnostic

10 JV Parameters

Note: If Monitoring is selected before uploading a new configuration, it displays the previous
configuration and the present OSSDs and Warning status.

The table below shows the Monitoring Menu.

[6{®]\ DESCRIPTION

Click this button to save the Monitoring info in a text file (.txt).

Click this button to toggle the graph coordinates between Cartesian and Polar.

inch Click this button to toggle the graph unit of measurement between inches and millimeters.

Click this button to move (drag) the graph in any direction. Once finished re-click on the button.

Click this button to zoom in on the graph. Clicking multiple times continues to zoom in.

Click this button to zoom out on the graph. Clicking multiple times continues to zoom out.

Note: If Errors are detected, the monitoring function displays a popup window with all the detected
errors. The device will switch into a Lock status.

Note: To go back to Programming, click on the Programming item or on the white left-pointing arrow.

© © 554
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APPENDIX

ACCESS CONTROL
Assign or change passwords
To assign or change the password, the device must be connected (Online).

1. Inthe DLSentinel Device Selection, click on Scanner and select Settings > Change Access Controls.

il COATALOGIC

[ —
£ e [ Nt
worl B
[ R trom scamer . SLs-Ms0812 Cluster Demo  FW:02.01.0058  SLS M5 master g
B setings . Changa network corfiguration ! - 10238 38 155
e ==

L Pe

»
ke

Cluster GUI

2. To change or assign the password or access type, you must enter the current one.

Here the user must enter the DLSentinel password to proceed (default password “admin”, if not changed).

©DATALOGIC |

sLsMe0812 ClusterDamo  FW: 02.01.00.50
M sous) PwwR
50

sLS-RS SLS RS Siave L

50 10.238.35.186
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3. Enter the new password twice then choose the password type:

e Write Only (required only when loading the configuration to the device),
e Read / Write (required when connecting and when loading a configuration to the device),
e None (no password required).

SOATALOGIC

sLsms sz ' ClusterDemo  FW:02010088
" |1 T

SLS-RS s
50

SCANMER STATUS: WORKING

4. Then click OK to proceed.
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Reset a password
To reset a password, the device must be connected (Online).

1. Inthe DLSentinel Device Selection window, click on Scanner and select Settings > Reset Password.

LISl GDATALOGIC
T

Ss-s0012 ClusterDemo  FW:0201.0058  5LSMS master v
crange nesuo carngoraion

- sus @) Pwowe 10.238.39.183

Crange cress comons

Resat password s0 L .
Faciory reset
s 10.239.39.156

<

NOT CONNECTED

2. Contact Datalogic Technical Support and send the serial and the magic number shown. A new password
will be communicated to the User.

SOATALOGIC

SCAMNER STATUS: WORKING
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FIRMWARE UPDATE
To update the firmware, proceed as follows:
1. Start the DLSentinel GUI and select the new configuration task.
2. Enter the Discovery mode and select an online device.
3. Once the device is selected, click Scanner on the menu and choose the firmware update option.

4. Enter the device password (default password “admin”, if not changed) to access the firmware update
option.

File Scanner Options =T x

#t B ! GOATALOGIC

Discovery 4

Working ~

SLS-M5-0812 Test-Schino FW: 02.01.00.20 SLS M5 master :Qf

SLS-SA TEST
! SLS-SA5
10.239.39.138
Test-Schino S0
SLS-M5-0812 —
! 10.239.39.144 @

Slave no. 1

M satus ) PW:wR 10.239.39.144

@

.
SLS-R5 { S0 SLS R5 Slave Q
.

10.239.39.146

Q Password ||

0K Cancel

NOT CONNECTED

5. In the Firmware update section (Package section), click on ZIP Archive to search and select a previously
downloaded new firmware version (from the Datalogic website).

6. Once the new firmware version is selected, click on Load (Configuration Upload). During the Firmware
Update the device will go offline.

—

E |:] Firmware uploading...40%
R

7. When the firmware version is completely loaded, the user enters the Offline-Test mode to create a
configuration and test the new firmware version.

8. If the firmware version is compatible with the device (i.e. the device configuration is correct and with no
failures) click on Accept, otherwise click on Reject (Validation).
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FACTORY RESET

The Factory Reset procedure resets the default password (“admin”), the password type (see Access Control), the
device IP address and any saved configuration.

To perform a Factory Reset, proceed as follows:

1. Inthe DLSentinel Device Selection, click on Scanner and select Settings > Factory Reset.

2. A message will appear informing the user that all devices of the cluster will be restored to factory
configuration and the current configuration will be lost. Click OK to proceed.

WARNING

All devices of the cluster will be
restored to factory
configuration. The current

configuration will be lost.

OK Cancel

3. A new window will prompt the user to enter the device password (default password “admin”, if not
changed).

4. A message will appear informing the user that the operation will take a few minutes. Subsequently, all
devices will be restarted. Click OK to proceed.

WARNING

This operation will take a few
minutes. At completion, all
devices will be restarted. Do you

want to continue?

0K Cancel

5. At completion, the Getting Started page will appear and the device will show a “Waiting Configuration”
message (see icon below).

WAITING CONF
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